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1. CONTENTS 
 
The Fairmount Automation Controller Series, Model 2000 (FAC-2000) is a general-purpose, 
highly configurable, multi-loop process controller. This instruction bulletin describes Fairmount 
Automation’s Schema Viewer®—a software package used to download programs (i.e., schemas) 
into the FAC-2000 controller.  
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2. INTRODUCTION TO Schema Viewer 2000™ 
 
Schema Viewer is a communications utility used to download programs into the FAC-2000 
series controller.  It also serves, as its name implies, as a viewer for control schemas 
developed using Fairmount Automation’s Design Pad 2000 software package.  (A schema is 
a graphical representation of a control scheme to be executed by the FAC-2000 controller.)  
In addition to exporting schemas into a controller, Schema Viewer can perform most of the 
controller communication functions available in Design Pad.  These functions include 
controller calibration, execution code updating, schema importing and more. 
 
 

2.1 HARDWARE AND SOFTWARE REQUIREMENTS 
 
To use Schema Viewer, your computer must have: 
 

• An 80486 (or compatible) CPU or greater 
 
• 8MB (or more) of RAM 
 
• A hard disk with 8MB of available disk space 
 
• A serial communications port (to interface with the FAC-2000 controller) 
 
• A 1.44 floppy drive (for installation) 
 
• Windows 95 or higher 
 
• A Windows-compatible mouse 
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3. USING SCHEMA VIEWER 
 
The following sections describe the functionality available in Schema Viewer. 
 
 

3.1 Creating a Control Schema 
 
A schema is a collection of interconnected functional operator blocks that form a control 
strategy.  It is a graphical block-diagram that represents the algorithm that is to be run on the 
FAC-2000 controller.  To display a schema file, select the Open item in the File menu and 
choose a file with a .scm extension.  Schema Viewer will display each file in a separate 
window. 
 
A sample schema is shown in Figure 1.  It contains a number of operator blocks, including a 
PID Control operator, an Analog Input operator, two Bargraph operators, several Numeric 
Display operators, and more.  These operator blocks are interconnected—the output signal of 
one operator feeds the inputs of others.  For instance, in Figure 1, the output of the PID 
Control operator feeds the Right Numeric Display operator.  
 
Schemas contain two types of signals that connect operator blocks: analog signals (floating 
point values) drawn in red, and digital signals (boolean value, i.e., true/false or high/low) 

 
Figure 1.  A typical Schema Viewer "program": a schema diagram of a 
simple PID controller. 
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drawn in blue.  The signal connections are made at an operator’s input or output pin.  An I/O 
pin is drawn as a short line attached to a small circle: .  The unfilled circle indicates that the 
pin is not connected.  When the pin is connected, Schema Viewer fills in the circle: . 
 
Each operator block has a list of properties associated with it. These properties determine the 
characteristics and behavior of each operator.  To view an operator’s property sheet, position 
the mouse cursor on the operator and double -click the left mouse button.  For example, the 
property sheet for the Set-Point Constant operator of Figure 1 is shown in Figure 2 
 

 
 

Figure 2.  Properties of Analog Input 1 object. 

 
For a complete reference of schema operators, their associated properties, and other aspects 
of schema design, refer to the Design Pad 2000 Professional Instruction Bulletin 
(Fairmount Automation Technical Bulletin 9110-0002). 
 
 
 

3.2 Controller Properties 
 
A schema has a list of controller properties that determine the behavior of the FAC-2000 as it 
executes the schema.  These properties include the schema execution frequency, the behavior 
of faceplate keys, and the presentation of adjustable constants and A/M operators.  To view 
the controller properties, select the Controller Options item from the Schema menu.  Schema 
Viewer will respond with a Dialog Box resembling the one shown in Figure 3. 
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The General Tab of the Controller Options menu contains the following properties: 
 

Loop sampling time : This parameter specifies the time in milliseconds between 
consecutive iterations of the schema.  The minimum loop sampling time is 10 

milliseconds; the maximum loop time is 28,800,000 milliseconds (8 hours). 
Latency time for non-critical broadcast operators:  This parameter specifies the 
time in milliseconds between network broadcasts (for non-critical broadcast 
messages). 
 
Display update time : This parameter controls the refresh rate for the numeric and 
bargraph displays on the FAC-2000 faceplate.  It corresponds to the amount of time 
(in milliseconds) between display updates.  The minimum update time is 100 
milliseconds; the maximum update time is 28,800,000 milliseconds (8 hours). 
 
Text brightness for system messages: The alphanumeric displays have a 
brightness setting between 0-15.  This parameter controls the brightness setting for 
system messages.  System messages include the Set Menu  information, A/M Menu 
information, and any controller error conditions that may arise. 
 
 

The SET Menu tab of the Controller Options dialog contains the following properties: 
 

 
 

Figure 3.  Controller Options dialog. 
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SET activation time: When the SET button is pressed (and held down for the SET 
activation time) on the FAC-2000 faceplate, the alphanumeric displays present a list 
of constants that can be adjusted using the up/down arrow keys.  This SET activation 
time parameter is the amount of time (in milliseconds) the SET button must be held 
down before the controller enters the Set Menu.  A long activation time may lower 
the risk of unauthorized Set Menu access by personnel that are experimenting with 
the device—pushing buttons to “see what happens”. 
 
SET operation timeout: When the SET button is pressed on the FAC-2000 
faceplate, the alphanumeric displays present a list of constants that can be adjusted 
using the up/down arrow keys.  After the constant values are adjusted, the user 
should press the SET button again to exit the Set Menu.  If the operator leaves the 
unit without exiting SET mode, the FAC-2000 will automatically exit Set Mode after 
this SET operation timeout time elapses.  This timeout parameter is expressed in 
seconds.  (The FAC-2000 controller measures the elapsed time between keypad 
input.  If the device is in Set Mode and the time of keypad inactivity exceeds this 
timeout value, the controller will automatically exit Set Mode.) 
 
SET delay before key repeat: This parameter determines the behavior of the 
UP/DOWN arrow keys on the FAC-2000 front panel.  The UP/DOWN arrow keys 
are used to adjust a parameter value in SET mode—when a key is pressed, the 
parameter is increased or decreased by a pre-specified increment.  If the arrow key 
is held down, the parameter value will be continually adjusted.  This property specifies 
the time (in milliseconds) before automatic repeated increments begin.  
 
SET key repeat time: As explained above, a parameter value will be continually 
changed (by a pre-specified increment) if the UP or DOWN arrow key is held down.  
This parameter specifies the time between parameter increments. 
 
Adjustable constant ordering: The Analog Constant and Digital Constant 
operators have a property called ‘Front Panel Access’.  When this property is set to 
either ‘Operator level’ or ‘Engineer level’, the constant value can be adjusted from 
the FAC-2000 faceplate, using the SET and arrow keys.  When the SET key is 
pressed, a list of adjustable constants will be presented on the alphanumeric displays.  
(‘Engineer level’ constants are password-protected—they are not accessible until the 
correct password is entered.)  This property specifies the ordering of this list. 
 
 

The A/M Menu tab of the Controller Options dialog contains the following parameters: 
 
A/M delay before key repeat: This parameter determines the behavior of the 
LEFT/RIGHT arrow keys on the FAC-2000 front panel.  The LEFT/RIGHT arrow 
keys are used to adjust the manual output value of an A/M operator or Controller 
block.  When a LEFT/RIGHT key is pressed, the parameter is increased or 
decreased by a pre-specified increment.  If the arrow key is held down, the 
parameter value will be continually adjusted.  This property specifies the time (in 
milliseconds) before automatic repeated increments begin.  
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A/M key repeat time: As explained above, a manual output value will be continually 
changed (by a pre-specified increment) if the LEFT or RIGHT arrow key is held 
down.  This parameter specifies the time between output increments. 
 
A/M state in alphanumeric display: If this property is checked, the top-line of the 
alphanumeric displays will indicate if the controller is functioning in automatic, manual, 
or mixed mode.  Otherwise, if this property is not checked, the FAC-2000 controller 
will not display the operational mode. 
 
A/M operator ordering: The PID Controller, PI Controller, PD Controller and 
A/M Button operators may function in automatic or manual modes.  In general, a 
schema will contain only one of these objects.  However, complex control schemes 
may require more than one.  In the single A/M operator case, pressing the A/M key 
on the FAC-2000 front panel will toggle between automatic and manual modes.  In 
the multiple A/M operator case, a list of A/M objects will be presented on the 
alphanumeric displays when the A/M key is pressed.  (The arrow keys are then used 
to select the desired A/M object.)  This property specifies the ordering of this list. 
 
 

 
 

3.3 Schema Properties 
 
General information about a schema, including its author, creation date, and design notes is 
also available.  To view this information, choose the Schema Properties item from the Schema 
menu.  Schema Viewer will present a dialog box resembling the one shown in Figure 4. 



Schema Viewer 2000 Instruction Bulletin Using Schema Viewer 
 
 

 11 

 

 
 
 
 

3.4 Protected Schemas 
 
Some schema documents may have been password protected to prevent unauthorized access.  
When Schema Viewer opens a password-protected file, it displays a blank document (as 
shown in Figure 5).  In order to unlock it, you must click on the document window and then 
enter the correct password. 
 

 
Figure 4.  The schema properties dialog box. 

 
 

Figure 5.  When Schema Viewer opens a locked schema document 
it does not display its contents.   
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NOTE:  You may still be able to export a password-protected schema to a control station 
even if cannot view it.  
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4. Workspaces 
 

Fairmount Automation’s FAIRNET network protocol enables multiple control stations to 
communicate with one another over a dedicated bus.  Before FAIRNET was released, 
schemas were generally designed for use in a single isolated control station.  The new 
networked-controller architecture supports distributed control strategies requiring multiple 
controller stations to regulate many inter-related processes.  Schema Viewer 2000 uses 
workspaces to organize the collection of schemas that form a multi-station control strategy.  
But workspaces can be used to organize any collection of schemas—even schemas that are 
loosely related or not related at all. 
 
In addition to organizing schemas, workspaces provide a means to explore the configuration of 
communication networks, OPC server nodes, human-machine interfaces (HMIs), and to 
access (communicate with) stations on a controller network. 
 

4.1 The Workspace Window 
 
The workspace document exists within the workspace window—a window normally docked 
on the left side of the application’s client area (see Figure 6).  To view the workspace 
window, select the Workspace item from the View menu.  It may sometimes be useful to hide 
the workspace window to provide more room on the screen to view a schema document.  To 
hide the workspace window, select the Workspace item from the View menu (or click on the 
window’s close button).  Notice that the Workspace item on the View menu toggles the visible 
state of the workspace window (when the window is visible, the menu item is checked, 
otherwise it is unchecked).  The visible state of the workspace window can also be toggled 
with the toolbar menu button shown to the left. 

View 
Workspace 

Window 
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Note :  Hiding the workspace window does not close a workspace document—a workspace 
is still active while the workspace window is hidden. 
 
The workspace window is always displayed on top of other windows in the Schema Viewer 
application.  By default, it is docked on the left side of the screen.  But it can be positioned 
(and resized) anywhere on the screen—it can be docked at the top, bottom, left side or right 
side of the client area or it can be floating anywhere on your computer screen (even outside 
of the application’s client area).  If the workspace window is docked and you wish to position 
it elsewhere, click on the window handle (two raised lines adjacent to the close button) and 
drag it to the desired location.  To resize the workspace window while it is docked, click the 
right mouse button on the inner edge of the window and drag it to the desired location.  When 
the workspace window is floating, you can resize it as you would any other window. 
 
The workspace window is used to manage a collection of controller schemas and controller 
communication networks.  The workspace window has two sections:  the Files section and 
the Networks section.  A sample workspace window is shown in Figure 6—Figure 6a 
displays the workspace with the Files section active, and Figure 6b displays the workspace 
with the Networks section active.  The files section lists all the schema documents, HMI 
documents, and OPC server configuration files that are part of the workspace.  To activate 
the files section, click on the Files tab.  The networks section of the workspace window lists 

  
 (a) (b) 
Figure 6.  The workspace window, including (a) the File-View tab and (b) the 
Network-View tab. 
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all the communication networks that the workspace manages.  To activate the networks 
section, click on the Networks tab. 
 
 

4.1.1 Opening and Closing Workspaces 
 
Schema Viewer can only have a single workspace document open at any given time.  If you 
would like to open a workspace document, you must first close the workspace document you 
are presently working with.  To close a workspace, select the Close Workspace item from the 
File menu.  When Schema Viewer closes a workspace, it also closes all other open 
documents and their associated windows.  
 
To open an existing workspace, select the Open Workspace item from the File menu.  
Schema Viewer will provide you with the familiar Windows Open File dialog where you can 
browse for the desired workspace.  If a workspace is open when you attempt to open another 
one, Schema Viewer will first close the open workspace and then prompt for the new 
workspace to open. 
 
Schema Viewer maintains a list of recently opened workspace documents in the Recent 
Workspaces item of the File menu.  To open a recently-accessed workspace document, select 
the Recent Workspaces item in the File menu.  A sub-menu will appear listing the four most 
recently opened workspace documents.  If the workspace you wish to open is on the list, 
select it.  (You can change the number of entries in the recent-file list—see section 6.1.) 
 
 
 
 

4.2 Workspace File View 
 
The workspace window has two views:  a File View (Figure 6a) and a Network View (Figure 
6b).  The file view displays all the schemas, HMI documents, and OPC server configuration 
files that are referenced in the workspace.  It organizes these documents in a graphical 
hierarchical tree format, using folders to group related files.  The file view displays the name 
of each document alongside a small graphic that indicates the type of document it is (  for a 
schema file,  for an HMI file, or  for an OPC-server configuration file).  
 
Schema (.scm) files and HMI (.hmi) files referenced in the workspace do not need to reside 
in the same disk directory as the workspace (.dpw) file.  They can be located in different 
directories, in different drives, and/or in different computers on a local area network.  The 
workspace file records a link to each document referenced in the workspace, rather than 
incorporating the document files within the workspace file.  Since only a link is recorded, a 
problem could arise if the document referenced in the workspace no longer exists or has been 
moved to another location.  If Schema Viewer cannot locate a file referenced in the 
workspace, it will prompt you for its new location. 
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The workspace File View offers a convenient location to access schema files and HMI files.  
You can open a document referenced in the workspace simply by double -clicking on the 
document name in the workspace window (or you can right-click on the workspace item and 
select Open File from the drop down menu).  You can also perform a number of functions 
with the workspace documents without opening them at all.  For instance, you can process 
(compile) a schema or export a schema to a control station.  The available commands are 
displayed in a drop-down menu when you right-click on the document name. 
 
 
 
 

4.3 Workspace Network View 
 
The Network View displays all the communication networks that are part of the workspace 
(see Figure 6b).  It organizes the communication networks in a graphical hierarchical tree 
format.  The workspace is the root node of this tree and the networks it contains are its first-
level sub-nodes.  Each network can have sub-nodes representing the schema files for the 
control stations on that network or the HMI files and OPC server files for PC stations on that 
network.  Each control station or PC on the network in turn can have sub-nodes representing 
the signals that the station is to broadcast on the associated network. 
 
Each item in the Network View tree has descriptive text alongside a small graphic that 
indicates the type of entry it is.  For network items, the tree displays the network name next to 
a  graphic.  For schema items, the tree displays the schema file name next to a  graphic.  
For HMI items, the tree displays the HMI file next to a  graphic.  For OPC-server items, 
the tree displays the name of the configuration file next to a  graphic.  And for broadcast 
signal items, the tree displays the name of the signal next to a  graphic (for analog 
broadcasts, including network-enabled Constant operators),  graphic (for digital 
broadcasts),  graphic (for mixed broadcasts, including network-enabled A/M Button 
operators). 
 
 
 

4.3.1 Accessing Network Configuration Information 
 
The workspace maintains configuration information on each of its networks (e.g., the network 
type, the latency time for critical broadcasts, the schemas assigned to each network, the 
broadcast signals that traffic each network, etc.).  Schema Viewer encodes this information in 
network configuration files and packages them with a schema to program a FAC-2000 
control station.  (See section 5.2 to learn how to export a schema and its associated network 
configuration files to a controller).  The network configuration files provide the control station 
with all the information it needs to participate in a controller network. 
 
Schema Viewer provides two useful dialogs to obtain this “nuts and bolts” information about a 
controller network and its broadcast signals: the Network Properties dialog and the Network 
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Broadcast Signal Properties dialog.  To access either dialog, first select the Network View tab 
in the workspace window.  Next, right click on the subject network, and select the desired 
item (Network Properties or Network Broadcast Signal Properties) from the drop down menu.  
Figure 7 shows a sample Network Properties dialog.  It displays the following information:   
 

Network Name .  The name of the network (displayed in the Network View tab of 
the workspace window). 
 
Network ID.  A unique identifier used to determine if a station belongs on the 
network.  (When a controller is physically connected to a network, its Network ID 
must match that of other stations on the network.) 
 
Network Version.  An integer value that tracks changes in a network’s 
configuration.  FAIRNET uses this parameter to maintain a consistent set of 
configuration files for all stations on a network. 
 
Network Type .  FAIRNET supports point-to-point networking and multi-drop 
networking.  In a point-to-point network, two devices are linked directly to one 
another over a two-way channel (communication with additional devices is not 
possible on this channel).  In a multi-drop network, several devices (two or more) 
share a common communications channel.  Devices can be added to (or removed 
from) the common channel as required.  The FAC-2000 controller includes one RS-
232 port for point-to-point networking and one RS-485 port for multi-drop networking. 
 
Critical Broadcast Latency Time .  FAIRNET supports deterministic and non-

 
 

Figure 7.  The network properties dialog. 
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deterministic messaging.  Deterministic messages are reserved for the most critical 
signals in a networked control system.  A FAIRNET network guarantees that these 
signals are transmitted at regular intervals.  This parameter specifies the length of the 
interval between successive critical message transmissions (expressed in 
milliseconds). 
 
Network Nodes.  Information about each node assigned to the network, including: 
 

Node.  The name of the node (schema document, HMI document, or OPC server 
configuration document) 
 
Port.  The PC COM port that Schema Viewer uses to communicate with the 
network node.  For schema documents, the port should always be set to 
“DEFAULT”.  For HMI documents or OPC server configuration documents, this 
parameter indicates which PC port the HMI software uses to communicate with 
the network. 
 
Hardware Mode.  The hardware mode indicates the communications protocol (at 
the physical layer) that the node uses to participate in the network.  For a point-
to-point network, both nodes must use the RS-232 protocol.  For a multi-drop 
network, all nodes must use either RS-485 or a memory pipe (all nodes must be 
one or the other).  If a multi-drop network contains a schema document (e.g., a 
FAC-2000 control station), then all nodes must use RS-485.  (The memory pipe 
option is reserved for virtual controller networks.  A virtual network is a PC 
simulation of a controller network involving multiple applications that interact over 
a memory pipe.  Each application represents a distinct station on the network.) 
 
Station ID.  An integer value that uniquely identifies each node in network.  
FAIRNET uses this parameter to determine the source and destination of a given 
communication message. 
 
Station Type.  FAIRNET uses a master/slave architecture to arbitrate 
communication messages.  One device on the network—the master device—
coordinates all the network traffic.  All other devices are slaves to the network 
master—they transmit information on the network only when prompted to do so 
by the master device.  FAIRNET automatically selects which station on the 
network will serve as the master. 
 
Master Rank. Every station in a FAIRNET network has the capacity to function 
as the network master.  If the master goes offline, one of the remaining slave 
devices on the network will automatically take on the master role.  This 
parameter determines which device on the network assumes the master role (the 
active station with the lowest master rank). 

 
 
Figure 8 shows a sample Network Broadcast Signal Properties dialog.  It displays the following 
information: 
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Signal Name .  The name of the broadcast signal (corresponds to a broadcast operator in a 
schema). 
 
Message ID.  A unique identifier assigned to each broadcast signal.  (Digital broadcast 
signals from the same station may have duplicate message identifiers.) 
 
Bit Position.  In order to optimize network usage, FAIRNET encodes digital broadcast 
signals from each station into 16-bit integer values (each integer value encodes the states of 
16 digital signals).  The bit position parameter indicates which bit in the encoded integer value 
represents the given digital broadcast signal. 
 
Source Station ID.  The station identifier for the node that transmits the given broadcast 
signal.  (Each node in a controller network is assigned a unique Station ID—see the Network 
Properties dialog.) 
 
Operator ID.  A unique identifier used to associate broadcast and receiver operators. 
 
Broadcast Type .  The type of networking operator: analog broadcast, digital broadcast, 
mixed broadcast, network-enabled A/M Button, or network-enabled Constant. 
 
Critical?  FAIRNET supports deterministic and non-deterministic messaging.  Deterministic 
messages are reserved for the most critical signals in a networked control system.  A 
FAIRNET network guarantees that these signals are transmitted at regular intervals.  

 
Figure 8.  Broadcast signal properties dialog. 
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FAIRNET also transmits non-critical messages at regular intervals but does not guarantee 
that it will always do so—occasionally, during periods of heavy network traffic, some non-
critical message transmissions may be delayed.  This parameter indicates if the given 
broadcast signal is or is not critical. 
 
Latency.  The time interval (in milliseconds) between successive broadcast transmissions.  
All critical broadcasts in a network have the same latency time (it is a property of the 
network).  Non-critical broadcast message latency times can vary from one station to another 
(the non-critical broadcast message latency time is a property of the nnetwork node). 
 
0% Map.  The lower limit of the broadcast signal range. 
 
100% Map.  The upper limit of the broadcast signal range. 
 
Initial Value .  The initial broadcast signal value. 
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5. Communicating with a FAC-2000 Controller 
 

Schema Viewer has built-in communications software that enables two-way communication 
between a personal computer and a FAC-2000 controller network.  To take advantage of 
these communication features, connect a serial cable  (Fairmount Automation Part Number 
0100-4000) between an unused PC communications port and the COM1 input (for RS-232 
communications) or the COM2 input (for RS-485 communications) of the FAC-2000 unit. 
 
The new FAC-2000 embedded code incorporates many changes in order to enable controller 
networking.  One significant modification is the protocol that the controllers use for 
communication.  In the new protocol, FAC-2000 controllers can process multiple 
communication messages simultaneously.  In first-generation FAC-2000 executable code 
versions (1.21 and below), controllers could only process a single communications message at 
a time.  Schema Viewer 2000 can communicate with controllers that use either first-
generation or second-generation versions of the embedded code.  (Older versions of Schema 
Viewer are only capable of communicating with controllers running a first-generation version 
of the embedded code.)  When using Schema Viewer 2000, you must specify which 
communication mode to use:  single-threaded mode for controllers with first-generation 
embedded code and multi-threaded mode for controllers with second-generation embedded 
code.  You set the communications mode in the communications tab of the Schema Viewer 
2000 Preferences dialog (see section 6.3). 
 
In this section, we describe all the PC-controller communication features available in Schema 
Viewer 2000. 
 
Note .  Prior versions of Schema Viewer prompted you for the PC communications port every 
time you initiated communication with a controller.  In Schema Viewer 2000, you only need to 
specify the communications port once.  You do so in the Communications tab of the Schema 
Viewer 2000 Preferences dialog (see section 6.3). 
 
 

5.1 Network Monitor Window 
 
When Schema Viewer 2000 communicates with a controller in multi-threaded mode, it 
displays communication results in the network monitor window.  (When using single-threaded 
mode, Schema Viewer uses simple dialog boxes to convey information to you.)  The network 
monitor window is normally docked at the bottom right corner of the Schema Viewer 
application window.  It displays text messages that describe the results of PC-controller 
communications.  For instance, when you execute the Analyze Network command (see section 
5.7), the network monitor window will display the results of the analysis. 
 
You toggle the visible state of the network monitor window (shown or hidden) from the view 
menu.  When you make the network monitor window visible, Schema Viewer displays a 
check mark next to the Network Monitor Window item in the View menu; it removes the check 

Network 
Monitor 
Window 
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mark when the window is not visible.  You can also toggle the visible state of the message 
window by pressing the corresponding button on the toolbar menu (shown to the right).   
 
The network monitor window is always displayed on top of other windows in the Schema 
Viewer application environment.  By default, it is docked on the bottom-right side of the 
screen.  But it can be positioned (and resized) anywhere on the screen—it can be docked at 
the top, bottom, left side or right side of the client area or it can be floating anywhere on your 
computer screen (even outside of the application’s client message).  If the network monitor 
window is docked and you wish to position it elsewhere, click on the window handle (two 
raised lines adjacent to the close button) and drag it to the desired location.  To resize the 
network monitor window while it is docked, click the right mouse button on the inner edge of 
the window and drag it to the desired location.  When the network monitor window is floating, 
you can resize it as you would any other window. 
 
 
 

5.2 Exporting a Schema to the FAC-2000 Controller 
 
This section describes how to program FAC-2000 controller, that is how to download a 
schema and associated network configuration files into the device. 
 
Schema Viewer 2000 includes communication features to export a schema from a PC to a 
FAC-2000 controller and also to retrieve (or import) a schema from a controller back to the 
PC.  The import feature is useful if you wish to view or edit the schema that a FAC-2000 
controller is executing (and you don’t have it available on the PC).  However, it also allows 
others to gain access to the schema (if the schema has been password protected, 
unauthorized access will be denied).  To completely prevent a third-party from accessing the 
schema, you can disable the import functionality entirely when you export a schema to a 
controller.  If you disable the schema import functionality, nobody will be able to access the 
schema executing in the controller—including you. 
 
To program the FAC-2000 controller, first open the workspace document that references the 
desired schema and contains the associated network configuration information.  (If the station 
will not be part of a controller network, you need not open the workspace document—you can 
simply open the desired schema document.)  Next, select the Export Schema with Import 
Enabled  item or the Export Schema with Import Disabled item from the Controller menu.  
Schema Viewer  will display a progress dialog (see Figure 9) with information about the 
programming process.  When the process is complete, Schema Viewer will automatically 
remove the dialog. 

Schema 
Export 
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When the FAC-2000 receives a new schema, it verifies that it can properly execute it.  
Namely, it ensures that it can execute the schema faster than the user-defined loop sampling 
time, ? t .  For instance, a very complex schema with scores of operators may require more 
than the default ? t = 0.1sec to execute.  In these cases, the FAC-2000 controller will notify 
Schema Viewer that the loop time is too short.  If this occurs, the schema must be erased 
from the controller.  Otherwise, the FAC-2000 may produce significant computational errors.  
The only recourse in this case is to use Design Pad to increase the schema loop time and to 
then re-download the schema into the device. 
 
 

As an alternative to using the 
Controller menu, you can export a 
schema to a controller from the 
workspace window.  If you use 
this method, you don’t need to 
open the schema file.  Just right-
click on the desired schema 
document item in the workspace 
window and select one of the 
Export Schema items from the 
drop-down menu.  (You can 
access the drop-down menu from 
both the Files and Networks tabs 
of the workspace window.) 
 

 
Figure 9.  Progress dialog displayed while 
PC communicates with a FAC-2000 control 
station.. 
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5.3 Importing a Schema from the FAC-2000 Controller 
 
Occasionally, it may be useful to retrieve a schema executing in the controller and display it in 
Schema Viewer.  To import a schema into Schema Viewer, connect the controller to your 
computer via serial cable and choose the Import Schema item from the Controller menu.  If the 
schema executing in the device contains a communications password, you will be prompted to 
provide that password before Schema Viewer retrieves the schema.  And if the schema was 
exported with import disabled, the controller will not allow you to import its schema at all. 
 
When Schema Viewer has completed importing a controller’s schema, it will display it in a 
new window, as an unnamed document. 
 
 
 

5.4 Controller Calibration 
 
The FAC-2000 controller is calibrated at the factory prior to delivery.  From time to time 
however, it may be necessary to re-calibrate the device.  Schema Viewer provides two 
calibration methods for the controller’s analog input and output channels.  One method is fully 
automated; the other requires significant user interaction.  Each method is described in detail 
in Fairmount Automation Technical Bulletin 9110-0003—the FAC-2000 calibration procedure. 
 
 

5.5 Updating the Controller Execution Code 
 
Occasionally, Fairmount Automation will add new function blocks to its suite of schema 
operators.  In order for schemas utilizing the new operators to work in the FAC-2000, the 
controller’s execution code must be updated. 
 
When Fairmount Automation makes changes to the controller software, it will distribute the 
execution code as a binary file.  The file will be entitled ctrlv###.$cc, where ### is the 
execution code version number times 100.  To determine the version of the code currently 
executing in your controller, select the Query Execution Code Version item from the Controller 
menu.  (Of course, the query will fail if your computer is not properly connected to the 
controller.) 
 
The process of updating the control code in the FAC-2000 controller requires several minutes, 
will erase the schema file the controller is running, and will reset the controller.  To do it, 
connect the controller to your computer via serial cable and select the Download Execution 
Code item from the Controller menu.  After displaying a warning message, Schema Viewer 
will prompt you for the .$cc binary file.  Locate the file, press the OK button, and wait for 
Schema Viewer to complete the code update. 
 
 



Schema Viewer 2000 Instruction Bulletin  Communicating with a FAC-2000 Controller 

 25 

5.6 FAC-2000 Network Licenses 
 
The FAC-2000 controller requires a network license to enable its networking features.  
Without a network license, a FAC-2000 controller will not be able to communicate with other 
devices. 
 
You can determine if a control station has a valid network license using the Query Network 
License Status command in the Controller menu.  If the controller does not have a network 
license, you can obtain one electronically (via e-mail) by contacting Fairmount Automation.  
First you will need to extract a network key from the control station you wish to obtain a 
network license for.  To do so, connect the controller unit to your PC via serial cable and 
select the Query Network License Key item from the Controller menu.  Schema Viewer will 
query the controller and will prompt you with the dialog box shown in Figure 10.  To obtain a 
license, complete the requested information, including your name, affiliated organization, and 
contact information (phone, fax, and address), as well as the controller particulars (model 
number, serial number, and a description of the application where it will be used).  (Schema 
Viewer remembers your contact information from one session to another, so you will not have 
to repeatedly enter it.)  Once you have completed the form, you can save the information to a 
text file (to include in a subsequent e-mail) or Schema Viewer can automatically prepare an e-
mail message and launch your e-mail software for immediate transmission.  Send all license 
requests to licensing@FairmountAutomation.com.  A Fairmount Automation representative 
will reply to your request with a network license file for the controller.  When you receive the 
license file, you export it to the device using the Download Network License File command 
from the Controller menu. 
 
 

 
 

Figure 10.  The network License Key dialog used to request a 
FAIRNET network license. 
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5.7 Analyzing Network Performance 
 
Schema Viewer provides a convenient mechanism to analyze the performance of a 
FAIRNET network.  The analysis includes statistics on transmission error rates, message 
transmission duration, and message transmission frequency.  To initiate the analysis, first 
connect the network’s master station to your PC using the RS-232 link (COM1 on the FAC-
2000).  Then, select the Networks tab in the workspace window, right-click on the desired 
network, and select the Analyze Network Messaging item from the drop-down menu.  The 
master station will collect communication statistics over a period of 40 seconds and will then 
report the results to Schema Viewer; Schema Viewer displays these results in its network 
monitor window. 
 
Figure 11, shows the results of a two-station FAIRNET network.  The results include a 
summary section with a count of all network messages that were transmitted during the 
analysis period, the number of messages that were not correctly processed, and the number of 
data errors that occurred.  It also includes a detailed breakdown of each type of message that 
was transmitted during the analysis period.  For each message type, Schema Viewer displays 

 
 

Figure 11.  Results of FAIRNET analysis. 
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the number of times it was transmitted; the number of times an error occurred during its 
transmission; the minimum, maximum, and average time (in milliseconds) time it took to 
transmit the message; and the minimum, maximum, and average time (in milliseconds) 
between consecutive transmissions of the same message type. 
 

5.8 Other Communication Features 
 
Schema Viewer offers additional communication features to query and/or alter the state of the 
FAC-2000 controller.  These additional features are described below. 
 
When you first received a FAC-2000 controller from the factory, you may have noticed that 
the device does not contain a schema file to execute.  When you powered a unit in this state, 
the alphanumeric displays contained the message “Awaiting Schema Download”.  You can 
return a programmed unit into this state by erasing the schema it is executing.  To delete a 
controller’s schema, connect the controller to your PC via serial cable and select the Erase 
Schema item from the Controller menu.  (When communicating with a controller code first-
generation code, you will need to restart the device in order for the command to take effect.) 
 
You can restart the FAC-2000 controller in one of two ways: Cycle the power to the device; 
or use Schema Viewer’s soft-reset feature.   To reset the device, select the Re-start Device 
item from the Controller menu. 
 
Fairmount Automation assigns a unique serial number to every FAC-2000 controller it 
manufactures.  This serial number is stamped on the bottom face of the controller.  You can 
obtain the controller’s serial number by visually inspecting the device or by querying it with 
Schema Viewer.  To query the device with Schema Viewer, select the Query Serial Number 
item from the Controller menu. 
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6. Customizing Schema Viewer 
 
 
You can customize some of functionality in Schema Viewer in its Preferences dialog (see 
Figure 12-Figure 15).  To access this dialog, select the Preferences item from the File menu.  
The Schema Viewer features that you can customize are described in the following sections. 
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6.1 Schema Viewer Preferences: General Section 
 
The general section of the Schema Viewer Preferences dialog includes the following 
parameters: 
 
Reload last workspace at startup.  If this item is selected, Schema Viewer will 
automatically open the workspace that was active during a previous Schema Viewer session.  
If it is not selected, Schema Viewer will not open any documents at startup. 
 
Recent File List Size.  Schema Viewer maintains a list of recently opened files (schema 
documents or HMI documents) in its file menu.  This parameter determines how many recent 
files Schema Viewer should track.  The maximum list size is 16 files. 
 
Recent Workspace List Size .  Schema Viewer maintains a list of recently opened 
workspace documents in its file menu.  This parameter determines how many recent 
workspaces Schema Viewer should track.  The maximum list size is 16 workspaces. 
 
Schema Export Button on Toolbar.  When you export a schema to a FAC-2000 control 
station, you can enable or disable schema importing from that station (see sections 5.2 and 
5.3).  To export a schema you can use the Controller menu or the toolbar button .  This 
preference item defines what the schema export button does: either download with import 
enabled, or download with import enabled. 
 
 

 
 

Figure 12.  Schema Viewer Preferences (General Tab). 
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6.2 Schema Viewer Preferences: File Access Section 
 
The file access section of the Schema Viewer Preferences dialog includes the following 
parameters: 
 
Default Docume nt Directory.  This item specifies the directory that Schema Viewer should 
reference whenever it displays the File Open dialog. 
 
 

 
 

Figure 13.  Schema Viewer Preferences dialog (File Access tab). 
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6.3 Schema Viewer Preferences: Communications Section 
 
The communications section of the Schema Viewer Preferences dialog includes the following 
parameters: 
 
Default Communications Port.  Indicates the default PC COM port that Schema Viewer 
should use when communicating with a FAC-2000 control station. 
 
Default Communications Hardware Mode.  Indicates the communications protocol (RS-
232 or RS-485) that Schema Viewer should use when communicating with a FAC-2000 
control station.. 
 
Controller Communications Mode .  Schema Viewer supports two methods of 
communicating with FAC-2000 control stations: single-threaded mode and multi-threaded 
mode.  FAC-2000 controllers executing first-generation executable code versions (version 
1.21 and below) communicate in single-threaded mode.  FAC-2000 controllers executing 
second-generation executable code versions (version 2.00 and above) communicate in multi-
threaded mode.  Prior versions of Schema Viewer cannot communicate in multi-threaded 
mode. 
 
 

 
 

Figure 14.  Schema Viewer Preferences dialog (Communications tab). 
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6.4 Calibration Tab 
 
Default Power Supply COM Port.  Indicates the PC COM port that Schema Viewer 
should use during the calibration process to manipulate the power supply settings. 
 
Default Meter/Switch Unit COM Port.  Indicates the PC COM port that Schema Viewer 
should use during the calibration process to manipulate the electronic meter or switch unit. 
 
Maximum Calibration Error.  Indicates the maximum allowable calibration error (in mA) 
for the analog inputs and analog outputs on the FAC-2000 controller . 
 
Default Path for Calibration File Results.  After Schema Viewer completes the 
calibration process, it generates a file summarizing the calibration results for each analog 
channel.  This parameter specifies the directory where the calibration results should be saved. 
 
 

 
\ 

Figure 15.  Schema Viewer Preferences dialog (Calibration). 
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